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Software version: Asanti 4.0 

Document version: February 25, 2019 

This tutorial demonstrates how to print jobs to a Tauro printer.  

Download the Asanti Sample Files via the Asanti Client (Help > Asanti Online > Download Sample Files). 

1. Send a job to Tauro 
1. Create a new Layout Job. 

o Select Printer: Jeti Tauro. 

o Select a Media e.g. 500x500mm. 

o Select a quality. 

o Select Finishing Margins “iCut Corner Marks, between 10”. 

2. Import image e.g. "ASANTI Visual 390x250.pdf". 
3. Place the image to the Sheet. 

The image is positioned in the lower left corner of the Sheet. 
 

4. Submit job > Print Files: Make and send to printer. 

o  When a Print Layout has finished processing in Asanti, it shows a rendered icon  in the Jobs window results tab next to the 
thumbnail of the Sheet. When the job is finished processing in Asanti, it gets a not-busy icon in the Jobs list. 

 

Working with Tauro 



Tutorial Working with Tauro 
 

 
   Page | 2  

 

o The job shows up in the Tauro GUI JobList “Ready” queue. 

5. In the Tauro JobList, click on the Layout to see its thumbnail and 
settings. 

 
6. Tauro 2500 GUI 3.x: Click Prepare Print and print the job. 

Tauro 2500 GUI 4.0 or higher/Tauro 3300: Select the layout, 
click “Add the selected layouts to the queue and start printing”. 
 

 
 
 

The Asanti Client shows an icon that the Tauro is busy printing 
the job. 

7. After the job is printed, in the Tauro GUI Ready queue, enable 
the checkbox next to the Layout. 

8. Click Finish. 

 
The job is moved to the Tauro GUI Finished Queue.  
The Asanti job gets a finished state. The printer icon next to the 
Asanti job is gone.  
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2. Edit an existing job in Asanti client 
1. In Asanti client, double click a job that is already sent to the 

Tauro GUI. 
2. Make a change e.g. rotate the image on the sheet. 
3. Submit job > Print Files: Make and send to printer. 
4. Wait until all processing is done in Asanti. 
5. To update the thumbnail of the job in the Tauro GUI, click the 

layout name again. 
 

 

3. Edit a Layout Job from Tauro GUI 
Select a Layout in Tauro GUI and click the “Edit Layout” button. This opens the Layout in Asanti client Layout 
Editor. The Asanti client should be running (Minimized) on the Tauro PC before you click this button. 

 

 

4. Media Thickness 
1. Use default Media Thickness in a job 

1. Create a new Layout Job. 
2. Select Printer: Jeti Tauro. 
3. (Re-)Select a Media in the Media drop down. This will fill in the 

default Thickness for this Media in the Thickness field. 

 

When creating a new Layout Job from template, the Thickness will be set the same as it was when saving 
the ticket template. This value could be different from the default Media Thickness. To get the default 
Media thickness, reselect the Media in the Media drop-down. 
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2. Setup default Media Thickness 

1. Open System Overview>Jeti Tauro>Media Hub. 
2. Select a Media that contains CPM’s in the Media column. 
3. To change default units, context click in the “Thickness” field, 

select the wanted units. 
4. Enter the default Thickness for the current Media and press 

<ENTER>. 
5.  (Re-)Select the media in a job: the new default thickness is 

automatically set. 

 

3. Override Thickness at Asanti job level  

1. Create a new Layout Job. 
2. Select Printer: Jeti Tauro. 
3. Select a media, the default thickness is set. 
4. Change the Thickness value. 
5. Import image "ASANTI Visual 390x250.pdf". 
6. Place the image to the Sheet.  
7. Submit job > Print Files: Make and send to printer. 
8. In the Tauro JobList, click on the Layout. 
9. The correct thickness is set.  

 

4. Set Thickness in Tauro GUI 

Thickness CAN be overwritten in Tauro GUI: 

1. In a job in Tauro GUI, change the thickness value and click the 

key. 

2. Click the  button to save changes. When you change 
Thickness in Tauro GUI for a specific job, the thickness of this 
job will never be overwritten anymore by Asanti.  
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5. Printer Parameters 
There are 2 types of Printer Parameters: Media Parameters and Print Mode Parameters. 

 

1. Media Parameters 

The following Media Parameters can be set in Asanti or Tauro: 
 Asanti setting Asanti Default Tauro setting 

1 Anti-static OFF AntiStatic 

2 Input Roller Bar ON InputRollbar 

3 Output Roller Bar ON OutputRollbar 

4 Media Sensitive to heat OFF IsHeatSensitive (not visible in GUI) 

5 Transport adjustment 0 μm Transport Adjust 

7 Extra Head Gap 300 μm Head Gap on Tauro = Asanti Extra 
Head Gap setting + Fixed minimum 
head gap (1mm) + 1.5mm if media 
feed support is enabled on Tauro 

8 Vacuum  
(Only for Tauro 3300) 

50 Value between 0 and 100. Only for 
Tauro 3300 (Not available yet on 
latest Tauro GUI, Asanti parameter is 
not honored yet by Tauro). 

 

 

Media Parameters can be set at the following levels: 

• Tauro task processor configuration (Service Mode only) 

• Media Hub>Media Category 

• Media Hub>Media 

• Asanti job Layout Editor 

• Tauro GUI  
 

 

 

 

 

Asanti job 
setting 

Tauro job 
setting 
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2. Media Parameters - Media Category 

In the Media Hub you can set the default media parameters for a specific Media Category. 

1. System Overview>Jeti Tauro >Media Hub. 
2. Select Media Category e.g. Generic. 
3. On the right side of the Media Hub, in the Printer Parameters 

section, click the button “Adjust…” 

o When a gray arrow icon is shown, the parameter is set the same as in the 
device Printer Parameters. 

o When a black arrow icon is shown, the parameter is set differently from 
the device Printer Parameters. 

o When you click the black arrow, the parameter is set the same as in the 
device category Printer Parameters. 

4. Click ok to close the Media Category Printer Parameters. 
 

3. Media Parameters - Media 

In the Media Hub you can set the default media parameters for a specific Media 

1. Open System Overview>Jeti Tauro >Media Hub 
2. Select Media e.g. Generic. 
3. On the right side of the Media Hub, in the Printer Parameters 

section, click the button “Adjust…” 

o When a gray arrow  icon is shown, the parameter is set the same as in the 
Media Category Printer Parameters. 

o When a Media has 2 Media categories filled in, the Media Parameters from the 
first Media Category are referred to. 

o If Media Category field is empty and parameter has a gray arrow: take values 
from device configuration settings. 

o When a black arrow  icon is shown, the parameter is set differently from the Media Category Printer Parameters. 

o When you click the black arrow, the parameter is reset to the same value as in the Media Category Printer Parameters. 

4. Click ok to close the Media Printer Parameters. 
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4. Media Parameters - Layout Editor 

When creating a job/hot ticket, Media parameters can be viewed/overruled. 

1. Create a new Layout Job. 
2. Select Printer: Jeti Tauro H 2500. 
3. Open Printer Parameters. The bottom part of the Printer 

Parameters represents the Media Parameters. When a gray 
arrow  icon is shown next to a parameter, the parameter is set 
the same as in the Media Printer Parameters. 

4. Change e.g. Extra Head Gap to 400 and press ENTER. A black 

arrow  icon is shown next to the parameter as it is set 
differently from the Printer Parameters of the selected media. 

5. Click the black arrow, the parameter is reset to the same value 
as in the Media Printer Parameters.  

6. Click ok to close the Printer Parameters. 
7. Submit job > Delete job. 

The following overview shows an example of where the Media Parameters in a job are taken from: 
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5. Media Parameters - Tauro GUI (job by job) 

By default a job in Tauro honors media and print mode parameters from the Asanti job. These parameters can still be overwritten in the Tauro 
GUI. When change a value in Tauro GUI job, this single printer parameter setting will never be overwritten anymore for this job by Asanti. 

1. Create a new Layout Job. 
2. Select Printer: Jeti Tauro. 
3. Click Media Inspector>Printer Parameters. 
4. Set UV Leading to 90%, UV Trailing to 90% and click OK. 
5. Import image e.g. ASANTI Visual 390x250.pdf 
6. Place image to the Sheet. 
7. Submit>Make and send to printer. 
8. The Tauro job shows UV Leading = 90%, UV Trailing = 90%. 

 
9. In Tauro GUI change UV Leading to 80%. A “*” is shown in Tauro 

GUI next to the UV Leading setting. This indicates the setting is 
edited on the Tauro GUI. 

10. Click the  button to save the changes. 
11. In Asanti edit the Layout Job. 
12. Click Media Inspector>Printer Parameters. 
13. Set UV Leading to 70%, UV Trailing to 70% and click OK. 
14. Submit>Make and send to printer. 
15. The Tauro job shows UV Leading = 80%, UV Trailing = 70%. UV 

Leading is not overwritten by Asanti because it was manually 
changed in the Tauro GUI. 
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6. Print Mode Parameters 

The following Print Mode Parameters can be set in Asanti or Tauro: 
 Asanti setting Asanti default Tauro setting 

8 Resolution  Resolution (not visible in GUI) 

9 Number of passes   Number of passes 

10 Direction (uni/bi)  Unidirection 

11 Screener  Screener (not visible in GUI) 

11b Smoothing (not visible in job printer parameters. Visible in print mode resource 
and in CPM. Visible in job printer parameters when logged in as Service).  

ON for Tauro 3300 + 2500 
DL. Off for other printers. 

Influences the smoothness of the 
screen (not visible in GUI) 

11c Solid Enhancement. Not visible in job printer parameters. Visible in print mode 
resource and in CPM. Visible in job printer parameters when logged in as Service.  

OFF Solid Enhancement (Tauro 2500 
V5.0.0/Tauro 3300 GUI) 

12 Droplets per dot 01DPD (8pl) Droplets per dot (not visible in GUI) 

13 UV Leading  UV Leading 

14 UV Trailing  UV Trailing 

15 Masking Mode (valid values are: Flat/Gradient. When job contains color + 
white/primer, only valid value is Flat.) 

 Mask 

16 Mask (Only for Masking mode Gradient, this value can be different from 0).  Mask value 

16b Step Mode (Regular/Irregular). This Print Mode only works in combination with 
Front End Manager 2.6.  

  

17 Print Density  Densities 

18 Turn Shuttle Outside of  Turn Shuttle Outside of 

 

 

 

 

 

 

 

 

 

 

 

Tauro 
Setting Asanti 

Setting 
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Print Mode Parameters can be set at the 
following levels: 

 

• Calibrated Print Mode (CPM) 

• Asanti job Layout Editor 

• Tauro GUI  

 

 

 

 

 

 

7. Print Mode Parameters – Calibrated Print Mode 

A Calibrated Print Mode (CPM) contains per color mode a selected print mode resource. The Print Mode resource contains the Print Mode 
parameters for this CPM. The settings of the selected Print Mode are imported in the Calibrated Print Mode. Once the CPM is created there is 
no link anymore to a Print Mode in the Print Modes resource. If a Print Mode resource is adjusted, no Calibrated Print Modes will be affected. 

 
 

To choose Print Mode settings when create a 
new CPM: 

1. Create a new CPM. 
2. Select the required Print Modes. 

3. Click the  icon next to the print 
mode to view/Change the printer 
parameter settings. 
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To change the Print Mode settings of an existing CPM: 

1. System Overview>Jeti Tauro H 2500>Media Hub. 
2. If you are using a generic CPM, the CPM must be duplicated 

first to another media. To duplicate a Generic CPM,  

o Drag the CPM to the media. 

o Choose Copy as available 

 

 

 

 

 

 

 

 

 

 

 

3. Select the Calibrated Print Mode. 
4. Click the cogwheel next to the Print Mode (Color on media part). 
5. Select edit print mode… 

6. Click the  icon to change Print Mode parameters. 
7. Change the Print Mode Parameters 
8. Click 2x ok to save the settings. 
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9. The new Print Mode Parameters are only set for the current CPM 
for the current print mode (e.g. for color on media). After making 
the changes, the color mode e.g. color on Media is displayed in 
red. The CPM in the Media hub shows a warning icon.  

 
The CPM in the job shows also a warning but the CPM can be used. 

 

When creating a new Layout Job from template, the Printer Parameter settings will be the same as set when saving the template. To use the 
new print mode parameters you must (re-)select your CPM in your job. 

10. To get rid of the warning you can recalibrate or ignore the 
warning: in the Media Hub, click the cog wheel at top-right of 
the Calibrated Printing Mode panel. Click “Accept changes”. 
 

 
 
 
 

 

 



Tutorial Working with Tauro 
 

 
   Page | 13  

 

To select Print mode settings from different Print Mode resource: 

1. Open Media Hub 

2. Click the  to allow making changes. 
3. Select a Calibrated Printing Mode (not a CPM for Generic 

Media). 
4. Click the cog wheel next to the print mode. Click “Edit Print 

Mode”, the used “Print Mode” resource is shown. You can 
switch to another Print Mode. 

5. Click OK. 

 

To edit Print Mode resource settings 

1. Open System Overview>Jeti Tauro H 2500>Print Modes 
resource. 

2. Duplicate a Print Mode. 
3. Edit the copy 
4. Enter a decent name, change the settings 
5. Click OK 
6. In the Edit Print Mode window or when creating a new 

CPM, select the new Print Mode.  
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8. Print Mode Parameters – Layout Editor 

By default the Print Mode Parameters are used from the CPM. In Layout Editor these individual settings can still be changed. 

1. Create a new Layout Job. 
2. Select Printer: Jeti Tauro H 2500. 
3. Open Printer Parameters. The top part of the Printer 

Parameters represents the Print Mode Parameters.  
4. Click ok to close the Printer Parameters. 
5. Submit job > Delete job. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

9. Print Mode Parameters – Tauro GUI (Job by job) 

By default a job in Tauro honors media and print mode parameters from the Asanti job. These parameters can still be overwritten in the Tauro 
GUI. When change a value in Tauro GUI job, this single printer parameter setting will never be overwritten anymore for this job by Asanti. See 
also Media Parameters - Tauro GUI (job by job) on page 8. 
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10. Printer Parameters – lookup on Job level 

Printer Parameters at job level are reset (to the values from 
CPM/Media) if: 

o Another CPM/Media is selected 

o You reselect the CPM/Media in the drop-down list 

o You enable/disable white checkbox in Media Inspector 

1. Create a new Layout Job. 
2. Select Printer: Jeti Tauro H 2500. 
3. Select e.g. Generic Media 
4. Open job Printer Parameters: Media Inspector> click button 

“Printer Parameters…” 
5. Enter e.g. UV Leading 55% and click ok. 
6. Open Printer Parameters again. UV Leading is still set to 55%. 
7. Click cancel. 
8. Re-select the Calibrated Printing Mode. 
9. Open Printer Parameters again. UV Leading is reset to e.g. 80%. 
10. Change UV leading again to 55% and click ok. 
11. Import image e.g. "ASANTI Visual 390x250.pdf". 
12. Place the image to the sheet. 
13. Submit Job > Make and send to printer. 
14. Select the job in Tauro GUI. 
15. Click the General tab. UV Leading is set to 55. 
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11. Printer Parameters - Save settings in a job template 

1. Create a new Layout Job. 
2. Select Printer: Jeti Tauro H 2500. 
3. Select Media Generic 
4. Select a Calibrated Print Mode (CPM) 
5. Open the Printer Parameters. Print Mode and Media parameters 

are used from the selected Media and CPM. 
6. Set e.g. UV Leading to 54% and click ok. 
7. File>Save as template.  
8. Create a new category e.g. Tauro. 
9. Enter the name “UV Leading 54”. 
10. Click Save. 
11. Open the Printer Parameters  
12. Set e.g. UV Leading to 58% and click ok. 
13. File>Save as template.  
14. Select Category Tauro.  
15. Enter the name “UV Leading 58”. 
16. Click Save. 
17. Submit>Delete job. 
18. File>New From templates. 
19. Open “UV Leading 54”. 
20. Open the Printer Parameters. UV Leading is set to 54%. Click 

cancel. 
21. Submit>Delete job. 
22. File>New From templates. 
23. Open “UV Leading 58”. 
24. Open the Printer Parameters. UV Leading is set to 58% Click 

cancel. 
25. Submit>Delete job 

Printer Parameters are not saved in the Job Set-up pre-sets. 
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12. Printer parameters - different settings for white/primer 

If White/Primer is enabled in the job, the Printer Parameters window allows you to enter different Print Mode Parameters for each 
combination. 

1. Create a new Layout Job. 
2. Select Printer: Jeti Tauro H 2500. 
3. Check White. 

 
4. Select a CPM that supports printing white 
5. Open Printer Parameters. Different Print Mode Parameters can 

be set for Color and for white. 
6. Close Printer Parameters. 
7. Submit job > Delete job. 
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• When Print Mode settings: Number of passes, Direction, UV Leading, UV Trailing, Turn shuttle outside off is set equal for color and for 
white/Primer, 1 print run is created in Tauro GUI with color and with white. Color and white can be printed in this case in 1 print run.  

  

When printing color + white, masking mode must be set to Flat and Mask must be set to 0. 

• When one of the Print Mode settings: Number of passes, Direction, UV Leading, UV Trailing, Turn shuttle outside off is set different for 
color and for white/Primer, 2 print runs are created in Tauro GUI. One for color and one for white. Color and white cannot be printed in 
this case in 1 print run. 
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6. Align a Sheet on the printer Layout 
By default each Sheet is aligned at 0.0mm on the print bed (= printer Layout). If this behavior must be changed for a job, you must go to the 
Printer Layouts window. 

Change the coordinates of a Sheet on the print bed 

1. Create a new Layout Job. 
2. Select Printer: Jeti Tauro. 
3. Set Sheet size e.g. 500x500mm. 
4. Layout sheets Inspector>Horizontally> choose “Single Sheet per 

Printer Layout”. 
5. Import image e.g. ASANTI Visual 390x250.pdf and place the 

image to the sheet. 
 

6. Switch to the Print Layouts view. 
7. Select the Sheet on the Print Layout. It is located 

at 0.0 mm 
8. In the x field, enter a new value (e.g. 200mm), click tab. The 

Sheet gets shifted to x: 200mm. 

 

For Tauro, the y coordinate of the sheet in the Print layouts view must be 0 mm. For Tauro it is only allowed to move the sheet on the print 
layout in the x direction. 

9. Submit job, make and send to printer. The Tauro GUI job also 
indicates the Sheet is positioned at 200mm. 
 

 

 



Tutorial Working with Tauro 
 

 
   Page | 20  

 

7. Roll Printing 
1. Tauro 4: Roll to Roll 

Tauro 2500 v3 and v4 require for roll media that Asanti  delivers the layouts centered. 

1. Create a new Layout Job. 
2. Select Printer: Jeti Tauro H 2500. 
3. Enable Print on roll. 
4. Size e.g. 1000mm. 
5. Go to the "Layout Sheets" inspector. 
6. Enable Keep sheets centered. This will center the Roll 

on the Tauro. 
7. File>Save as template. 
8. Create a new category with name e.g. Tauro. 
9. Save the ticket template with name e.g. Tauro Roll 

1000mm. 
10. Import an image e.g. ASANTI Visual 390x250.pdf. 
11. Drag the image on the sheet. If you want the image 

to be centered on the sheet, press c while dragging 
the sheet. 

12. Submit Job>Make and send to printer. 
13. Open the Tauro GUI. If in Tauro 3.0 GUI this roll media is not 

loaded, this new job will not be visible in Tauro GUI. To be able 
to load/unload media, the Tauro must be initialized. If it is not 

initialized click:  >   >  

Unload sheet media:  >  >  

Load the roll media:  >  >  



Tutorial Working with Tauro 
 

 
   Page | 21  

 

Select the media and thickness, enter the width 1000 and the length of the roll 

 

Click  

14. Select the job in Tauro job list. The roll is centered on the Tauro. 

15. To print the job, enable  next to the Tauro job. 

16. Click the  button (bottom of Tauro jobs list), this adds the 
job to the Print Queue. 

17. Enable the vacuum.  

18. Click  > . 
19. Enable Tension for Input and output side.  

20. Click  >  to go to 
the Print queue. 

21. Click  to start the queue. 
 

22. To create another job for roll media in Asanti client, choose 
file>New from templates, open the ticket template you 
previously saved. Place an image to the sheet, submit>Make 
and send to printer. 
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2. Tauro 5/6: MasterRollToRoll 

A MasterRollToRoll setup requires that Asanti  
delivers the layout NOT centered. 
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8. Combine Layers in 1 Print task 
1. Multiple layers from 1 Asanti job 

When White/Primer is not enabled in the Asanti Job Set-up inspector, a job is created in Tauro with only a print task for color. 

 
When White/Primer is enabled in the Asanti Job Set-up inspector, a job is created in Tauro with 1 Print task that includes multiple layers: e.g. 
color + white. If multiple layers are included in 1 Print task, they will be printed concurrent.

 
Some possible combinations of layers in 1 Print task: 

Asanti Layers Layers included in 1 Print task on 
Tauro 

Application 

Color only 
 

 

Color + Primer 

 

Color is printed on top of primer 

Color + Pre-white 
 

Color is printed on top of white 

Color + Primer + Pre-white 
 

Order of layers = Primer + White + Color 

Color + Post-White 
 

White is printed on top of color 
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Color + Primer + Post-White 
 

Order of layers = Primer + Color + White 

Color + Sandwich White  
(On media calibration) 

 

 
Day/night application: Printed on the Back of transparent 
media, image to be viewed through the media. The image 
is mirrored in Asanti. 
 
 

Color + Primer + Sandwich White 
(Calibration on media)  

Order of layers = Primer + Color1 + White + Color1 

Color + Sandwich White  
(On white Calibration) 

 

 
Day/night application: Printed on the Front of transparent 
media. The image is not mirrored in Asanti. 
           

Color + Primer + Sandwich White 
(Calibration on white)  

Order of layers = Primer + Color1 + White + Color1 

 

More info about sandwich printing refer to tutorial on Asanti Network: Creating Sandwich White jobs for Jeti Tauro. 

 

2. Merge 2 Asanti jobs on Tauro 

Other combinations of layers in 1 print task (e.g. C1 – Pre-White – C2) are possible if you create 2 or more jobs in Asanti. Refer to tutorial 
“Creating Sandwich White Jobs for Tauro” for more info. 
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9. Process-white 
When “Process-white” (=Spot white in Asanti 3.5) is selected as white mode in Asanti, Tauro will print white in the same pass as the process 
colors. This means Tauro will print jobs with white at the same speed as it does for jobs without white. This mode should only be used for 
white only jobs or when CMYK and white don’t overlap in the input file. If the source of white is set to “From image”, the mode can be set to 
“Process-white”. Asanti uses the print mode for Color on Media when printing Process-white. The Process-white mode can only be selected for 
Tauro, not for other printers. 

If “Process-White” mode is used in Asanti, the White layer on Tauro will get a checkmark in the “Process” column.  

 
 

Asanti doesn’t check if white and process colors overlap or not. The 
operator must manually make a choice between “Process-white” or another 
white mode. When white color overlaps areas with CMYK content, the 
operator should not select “Process-white”. 
 

Required software on Tauro: Tauro 2500 GUI 5.0 or higher + FEndMgr V 
2.5.7.0/Tauro 3300 + FEndMgr V 2.5.7.0 or higher. 
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10. Sheet DQS 

• By default Sheet DQS is enabled for Asanti jobs towards a Tauro task processor.  

• Sheet DQS means Asanti will render for each Sheet only the image block. The image block is 
the area on the Sheet where you have images and marks.  

• Asanti will send a JDF to Tauro indicating the position of the image block on the Sheet.  

• When Sheet DQS is enabled for a job, an orange icon is shown with the text “DQS” at the 
right-bottom of the Layout Editor. 

 

• When a Sheet is placed more than once on the Layout, its image block will only be rendered 1x. 

 

• Sheet DQS can be disabled in the Layout Editor by clicking on the orange DQS icon. The 

icon will change in DQS disabled  state. Turn off DQS is only needed in case of issues 
with Sheet DQS. 
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• With Sheet DQS OFF, the Sheet block is rendered = lay corner + all Sheet blocks.  

 

• Image DQS (render images and marks separately) is not possible to Tauro. 

 
 

11. Multiple Raster Link Task Processors 
If Asanti has multiple PDFRenders and raster links installed, all PDFRenders and raster link Task Processors will be used when printing 
multiple jobs/jobs with multiple sheets. Multiple raster links can send data to the Tauro at the same time. 
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12. Job updates 
When Asanti sends an update for an existing job, re-rendering or just re-sending JDF is needed.  

When only a JDF needs to be sent to Tauro, only the Raster Compose component becomes green. 

 
 

The following table shows an overview: 
Change in Asanti Layout Editor DQS ON DQS OFF 

Change job name, order number, remarks, customer 
info, Milestone (Due Date) 

Only a new JDF is sent Only a new JDF is sent 

Changes in Inspectors: Preflight/ColorManagement Re-render job Re-render job 

Change Media Re-render job Re-render job 

Change Media size Only a new JDF is sent Only a new JDF is sent 

Change Thickness Only a new JDF is sent Only a new JDF is sent 

Change CPM Re-render job Re-render job 

Change Printer Parameters Only a new JDF is sent  Only a new JDF is sent 

Move Sheet on Layout Only a new JDF is sent Re-render Layout 

Move image block on the Sheet Only a new JDF is sent Re-render Layout 

Move separate images on the Sheet Image block current Sheet re-renders Re-render Layout 

Add image to the Sheet Image block current Sheet re-renders Re-render Layout 

Add a new Sheet placed on a new Layout Image block new Sheet renders Re-render Layout 

Add a new Sheet to an existing Layout Image block new Sheet renders Re-render Layout 

Add/remove marks on a Sheet/image Image block current Sheet re-renders Re-render Layout 

Change Layout copy count Only a new JDF is sent Only a new JDF is sent 
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13. Job Deletion 
The info below describes which data is deleted on disk when deleting on Tauro or in Asanti. 

1. Deleting jobs only in Asanti client (Tauro 2500 GUI 4.0 or higher/Tauro 3300 GUI) 

• When deleting a job in Asanti, the job is automatically removed from the Tauro. 

• When free disk space < 60GB on Tauro (disk that holds the X2 Resources folder), Tauro will automatically remove PEC files from jobs 
in the Finished queue until disk has again 60 GB free. For jobs in the Tauro Ready queue, PEC files are not deleted. 

• When restore a job from the finished queue to the ready queue in Tauro, Asanti will automatically re-send the PEC files to Tauro if 
these files are missing in the Tauro job. 

Action jobs in Tauro ready queue jobs in Tauro Finished queue 

Job can be printed. V X (First need to move job to Ready queue) 

PEC files are deleted  
when free disk < 60GB 

X 
 

V 
 

PEC files are deleted  
when free disk > 60GB 

X 
 

X 
 

Delete Asanti job  
removes Tauro job 

V V 

It is best to move printed Tauro jobs to the finished queue as much as possible.  
This insures that the Tauro disk always has > 60GB free disk space. 

1. Create a new layout job. 
2. Select printer Tauro. 
3. Place an image on the Sheet e.g. ASANTI Visual 390x250.pdf. 
4. Submit job>Make and send to printer. 
5. On Tauro PC, Folders with files are written to 

o \x2resources\Images\xxx\ 

 Pec file (high resolution data) 

 Thumbnail 

 Xml files 

o \x2resources\Jobs\xxx\ 
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 XML files 

When the job is in the Tauro Ready list, the job can be printed. 
As long as the job is in the Ready queue, the PEC files are never 
deleted. 

6. When the job is printed, it is best to move the job to the 
Finished Queue. Select the checkbox next to the job in Tauro 
GUI (1) and click Finish (2). The job is moved to the Finished 
Queue. The PEC file inside the X2Resources folder is not 
deleted. When you would process a lot more jobs, it is possible 
that the PEC file of this finished job is deleted automatically to 
free up disk space. 
 
 

 
7. When a re-print is needed, the job first needs to be brought 

back to the Tauro Ready queue. Select the checkbox next to the 
job in Tauro GUI Finished queue (3) and click Restore (4). The job 
is moved to the Ready Queue.  
 
 
If the PEC file is missing because Tauro automatically removed 
it, Asanti will automatically resend the PEC file to Tauro (Asanti 
job shows activity in Raster Link task processor). 

 
8. When the re-print is done, manually move the job back to the 

Finished Queue. 
9. Asanti client> Delete Asanti job. The Tauro job is automatically 

removed. Data from X2Resources folder is automatically 
removed. 
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2. Deleting a job first in Tauro GUI (Tauro 2500 GUI 3.x) 

In Tauro GUI 4.0 or higher/Tauro 3300, it is not needed to delete the job manually in the Tauro GUI. The Tauro GUI 4.0 or higher/Tauro 3300 
job is automatically deleted when delete the Asanti job (See previous page). Also when free disk < 60 GB, the PEC files are automatically 
deleted in Tauro for jobs in the Tauro finished queue.  

1. Create a new layout job. 
2. Select printer Tauro. 
3. Place an image on the Sheet e.g. ASANTI Visual 390x250.pdf. 
4. Submit job>Make and send to printer. 
5. On Tauro PC, Folders with files are written to 

o \x2resources\Images\124\ 

 Pec file (high resolution data) 

 Thumbnail 

 Xml files 

o \x2resources\Jobs\34\ 

 XML files 

6. Tauro GUI: Select the Layout. 
7. Print the job, wait until the job is printed. 
8. Select the checkbox next to the Layout in Tauro GUI and click 

Finish. The job is moved to the Finished Queue. 
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9. Click the Finished Queue header to open the Finished Queue 
10. Select the checkbox next to the Layout in the Finished Queue 

and click Delete. Data from \x2resources\Images\124\ is 
automatically removed (This might take a few seconds). 

11. Asanti client: Select the Asanti job. Delete job. 
Data from \x2resources\Jobs\34\ is automatically removed 
(This might take a few seconds). 
 

3. Deleting a job first in Asanti client (Tauro 2500 GUI 3.x) 

(For Tauro 2500 v4/v5/Tauro 3300 see: Deleting jobs only in Asanti client (Tauro 2500 GUI 4.0 or 
higher/Tauro 3300 GUI) on page 29.) 

1. Create a new layout job. 
2. Select printer Tauro. 
3. Place an image on the Sheet e.g. ASANTI Visual 390x250.pdf. 
4. Submit job>Make and send to printer. 
5. On Tauro PC, Folders with files are written. 
6. Asanti client> Delete Asanti job. If the job is not finished yet, 

Tauro job automatically moves to the Finished queue. Data on 
Tauro disk is not removed. 

7. Manually delete Tauro job in the Finished queue. 

o Data from \x2resources\Images\124\ is removed (This might take a few seconds).  

o Data from \x2resources\Jobs\34\ is removed (This might take a few seconds). 

 

14. Reject results 
1. Reject Tauro Layout 

1. Create a new layout job. 
2. Select printer Tauro. 
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3. Import file “text boards 4 pages.pdf”. 
4. Enter Sheet size 800x800mm. 
5. Select al images and drag them to the Sheet so you get 2 

Sheets. 
6. Submit job > Make and send to printer. 
7. Tauro GUI: Select the checkbox next to Layout 2. 
8. Click the Reject button. 

The Layout gets a rejected icon. 
9. The job in Asanti gets an error state. Click on the error in the 

Asanti job list. The Problem Report shows that Layout 2 is 
rejected. 

10. Tauro GUI: Deselect the checkbox next to Layout 2. 
11. Tauro GUI: Select the checkbox next to Layout 1. 
12. Click the Reject button. 
13. The complete job is now rejected. The job is automatically 

moved to the Finished Queue. 
 

14. The Asanti Problem Report shows that Layout 1 and 2 are 
rejected. 
Within the Problem Report you can get rid of the messages by 
clicking “Acknowledge”. 

15. Edit the Asanti job. On Sheet 1 move the image a little bit on 
the Sheet. 

16. Submit>Make and send to printer 
In Tauro GUI, the job is automatically moved to the “Ready” 
queue. Layout 1 doesn’t show a rejected state anymore. 
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2. Reject Asanti Layout 

1. Create a new layout job. 
2. Select printer Tauro. 
3. Import file “text boards 4 pages.pdf”. 
4. Enter Sheet size 800x800mm. 
5. Select al images and drag them to the Sheet so you get 2 

Sheets. 
6. Submit job > Make and send to printer. 
7. Select the job in the Asanti client. 
8. In the results tab context click the name of the Layout > Reject 

Flat. 
9. Enter a comment and click “Reject”. 
10. A reject icon is shown next to the Layout in the 

Asanti job results tab.  
The Tauro job doesn’t show the rejected state. 

 

15. Job locking states 

• When the job is being edited in Asanti, the job in 
Tauro shows a locked state. This doesn’t prevent 
the user from printing the job. 

• When the job is selected in Tauro GUI, the job in Asanti shows a printer icon. When editing the Asanti job, a message is given that 
the job is being printed. The user can ignore this message and edit the Asanti job.  

1. Print Tauro job 

1. Create a new layout job. 
2. Select printer Tauro. 
3. Place an image on the Sheet e.g. ASANTI Visual 390x250.pdf. 
4. Set sheet size e.g. 500 x 500 mm 
5. Submit job>Make and send to printer. 
6. In Tauro GUI, the Layout gets a green icon (1), this means it is 

available to be printed. 
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7. Tauro GUI: click on the Layout to see its details. With Tauro 

2500 v4.0 or higher/Tauro 3300, the Asanti job shows a printer 
icon (2) when the job gets selected in the Tauro GUI. 

 
8. Edit the Asanti job. If the Asanti job shows a printer icon, the job 

can be edited but an informational warning is shown. Click “Edit 
Job” (3) to proceed. 
 
 
 

 

 
In Tauro GUI, the Layout gets a lock icon (4), this means 
someone is editing the job in Asanti. 
 

9. Submit job>Discard. 
 

10. Tauro GUI: Select another job. 
In Asanti client the printer icon disappears next to the 
previously selected job. 
 
 

11. Select your job again, Print the job. When the job is printing in 
Tauro, the same job in Asanti will show a printer icon (even 
though that job might not be selected on Tauro.). 
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16. Continue a layout in hold state 
If a layout is in hold in the jobs results tab (because the job was submit with print files: “Hold” or “Make And Hold”), it has a blue color in the 
jobs window. To continue the layout, context click the layout>Continue flat. 

  
 

 

17. Raster Preview a layout 
When a layout is in hold after the PDFRender (Submit>Make and hold) or when it is sent to the Tauro it is 
possible to Raster Preview the layout.  

1. Select a job in the Asanti jobs list that is rendered for Tauro. 
2. In the Results tab double click on the thumbnail of the layout 

(not on the name of the layout) to open the preview. 
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18. Disk full 
In Tauro 2500 GUI 3.x two disk space thresholds are set: Critical Level. = 35GB, Warning Level = 40GB  

In Tauro 2500 GUI 4.0 or higher/Tauro 3300, three disk space thresholds are set: Critical Level. = 30GB, Warning Level = 50GB, Image 
Delete level = 60GB 

• When disk space on Tauro PC drops below Warning 
Level: Asanti client Message Board 
shows a warning message. In the 
System Overview, Tauro shows a 
blue man icon. 

It is still possible to process a job 
to Tauro. 

 

• Tauro 2500 v4.0 or higher/Tauro 3300: While disk space on Tauro PC is below Image Delete level, PEC files are deleted on Tauro for 
jobs in the Finish queue. When the Tauro operator would move a job from the Finish queue to the Ready queue and the PEC file is 
missing on Tauro, Raster Link Task Processor on Asanti will automatically resend the PEC file to the Tauro. 

• When disk space rises above Warn Level: Disk space OK Signal sent to Asanti. 

• While disk space is below Critical Level: receiving of further image data from Asanti is blocked. An error is shown in the message 
board. 
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In the message board, the Tauro Task Processor shows a “red man” icon. 

 

 
 

19. Job statuses 
A job can have the following statuses: 

Action Asanti job list state Asanti results tab state Tauro job states Remarks 

Submit a job in Asanti with 
option hold/Make and hold. 

The Asanti job goes in 
hold before render (blue 
state). 

 

The Sheets show a blue color. 

 

Tauro 4: A job becomes available on 
Tauro but no layouts are shown. 

 

 

Submit a job in Asanti with 
option Make and send to 
printer. 
 
Or: 
Continue job in hold 
before/after render: in the 
results tab, context click the 
name of the Layout>Continue 
flat. 

During processing, flow 
identifier is green 

 , when done 
processing, white. 

 

Render (if job was in hold before 
render), Raster Link and Raster 
Compose process the layout. The 
layout gets a finished identifier. 

 

The layout becomes visible on Tauro. 
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Select a layout on Tauro. Tauro 4: Asanti Job shows 
a printer icon 

 

No special state Click a layout in Tauro GUI to select it. 

 

When an Asanti 
job shows a 
printer icon and 
you edit the 
Asanti job, a 
message is 
given. 

Select a layout of a different 
job on Tauro. 

Printer icon is removed 

 

No special state No special state  

Edit Asanti job. The job shows an edit and 
a hold icon 

 

No special state During the edit, all layouts of this job 
show a lock icon. 

 

It is still possible 
to print the 
layouts of this 
job. 

Action Asanti job list state Asanti results tab state Tauro job states Remarks 

A layout of the job is available 
in the Print queue on Tauro or 
a layout of the job is busy 
printing. 

Job shows a printer icon 

 
When no jobs are 
printing/in the print 
queue, the printer icon is 
removed. 

No special state The layout shows a busy state 

 

When an Asanti 
job shows a 
printer icon and 
you edit the 
Asanti job, a 
message is 
given. 

Move a Tauro job to the 
Finished queue. 

Job gets a green 
checkmark and flow 
identifier a finished icon. 

 

No special state Job shows a finished state in the finished 
queue. 
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Reject a layout on Tauro. 

 

No special state 

 

 

Delete Tauro job. No special state No special state Job is deleted  

Delete Asanti job. Job is deleted  Job is deleted  

 

 

 

20. Borderless Printing 
Borderless printing jobs are jobs where we print over one or more 
edge(s) of the sheet. A typical example of an Asanti borderless print 
job is a job where the image bleed is printed over the sheet edge.  

 

 

 

 

 

 

A borderless print job on Tauro will have a warning icon on the 
Thumbnail. When you hoover over the icon a tooltip will indicate that 
overprinting will be done. Notice that there is no indication how much overprint will be done. 
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